QUICK START

A fast track to the essentials of working with files, folders, and applications in the NEXTSTEP workspace

NEXTSTEP

Object-Oriented Software
We at NeXT have tried to make the information contained in this manual as accurate and reliable as possible. Nevertheless, NeXT disclaims any warranty of any kind, whether express or implied, as to any matter whatsoever relating to this manual, including without limitation the merchantability or fitness for any particular purpose. NeXT will from time to time revise the software described in this manual and reserves the right to make such changes without obligation to notify the purchaser. In no event shall NeXT be liable for any indirect, special, incidental, or consequential damages arising out of purchase or use of this manual or the information contained herein.

Quick Start copyright © 1994 NeXT Computer, Inc. 900 Chesapeake Drive, Redwood City, CA 94063. All rights reserved.

NEXTSTEP Release 3 copyright © 1988–1994 NeXT Computer, Inc. All rights reserved.
Certain portions of the software are copyrighted by third parties.

NeXT, the NeXT logo, NEXTSTEP, the NEXTSTEP logo, Digital Librarian, NeXTmail, and Workspace Manager are trademarks of NeXT Computer, Inc. Helvetica and Times are registered trademarks of Linotype AG and/or its subsidiaries. All other trademarks mentioned belong to their respective owners.

U.S. Pat. No. 4,982,343. Other patents pending.

Restricted Rights Legend: Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 [or, if applicable, similar clauses at FAR 52.227-19 or NASA FAR Supp. 52.227-86].

Written by Roy West
Book design by Jeff Yaksick
Illustrations by Nancy Serpiello and Jeff Yaksick
Production by Jennifer Sherer
With help from Helen Casabona, John Hamnett, and Adrienne Wong
Cover design by CKS Partners, San Francisco, California

This manual was designed, written, and produced with NEXTSTEP. Proofs were printed on a NeXT 400 dpi Laser Printer. Final pages were transferred directly from NEXTSTEP files to film using NEXTSTEP computers and an electronic imagesetter.
QUICK START
Before you start

You can get a quick introduction to NEXTSTEP™ by reading this book while sitting in front of your computer, trying things out as you go. But there are a few things you need to do before you start:

- Set up your computer and make sure NEXTSTEP is installed on it.

Your computer's owner's guide shows you how to set it up.

*Installing and Configuring NEXTSTEP* shows you how to install NEXTSTEP.

*Upgrading* shows you how to upgrade from an earlier release of NEXTSTEP.

- Get a user name and password from your system administrator.

If your computer is on a network, your system administrator will assign you a user name and password so you can log into your computer.

The NEXTSTEP workspace is where you get things done, imagine doing things you've never done before, and do things beyond imagination—all with a few keystrokes, some mouse clicks, and lots of windows.
## Contents

### Basics
2 Turning on the computer
3 Logging in
4 Entering the workspace
5 Using the mouse
6 Choosing commands
7 Logging out
8 Turning off the computer

### Applications
10 Starting up an application
11 Running multiple applications
12 Hiding an application
13 Unhiding an application
14 Quitting an application

### Windows
16 Organizing windows
17 Reordering windows
18 Scrolling

### Files
20 The File Viewer
21 Finding files and folders
22 Stocking the shelf
23 Customizing the application dock
24 Opening a file from the File Viewer
25 Opening a file from within an application
26 Creating a file
27 Saving changes to a file

### Editing
30 Typing text
31 Deleting and replacing
32 Moving and copying
33 Changing fonts

### Organizing
36 Renaming files and folders
37 Creating a folder
38 Moving files and folders
39 Copying files and folders
40 Deleting files and folders

### Mail, Printing, & Faxing
42 Opening your mail
43 Sending mail
44 Preparing a file for printing or faxing
45 Printing a file
46 Faxing a file

### For More Information
48 Clicking for help
49 Getting help with a task or topic
50 Searching for help
51 Reading more about NEXTSTEP
Turning on the computer

You turn on some computers with a single keystroke. Others have separate power switches for the computer, display, and peripherals.

1 If your display and other peripherals have power switches, turn them on.

2 Press the power switch on your computer.

Caution: Don’t turn on the computer if there’s a disk in the floppy disk drive, or NEXTSTEP won’t start up.

3 If you’re asked to pick an operating system, type n and press the Return key to start up NEXTSTEP.

To find out where the power switch for your computer is located, see its owner’s guide.
When NEXTSTEP finishes starting up, the login window opens on your screen (a window is a rectangular area containing information). You must log in to use the computer, unless you or your system administrator have set things up differently. The login process prevents unauthorized people from using your computer.

To log in you need a user name and password, which you get from your system administrator.

1. Type your user name in the Name field.

   The blinking vertical bar in the Name field marks the insertion point, where text you type is entered.

   If you make a mistake, press the Backspace key to back up over each character you want to retype.

2. Press the Tab key to move the insertion point to the Password field.

3. Type your password. Use the Backspace key to correct typing errors.

   Although the insertion point follows your typing, your password isn’t shown.

4. Press Return.

   If you typed your user name and password correctly, the login window closes and you enter the workspace.

   If you made mistakes while typing, the window shakes back and forth, indicating that your login attempt has failed. If this happens, go back to step 1 and try logging in again.

Tip: The Return, Tab, and Backspace keys may be labeled on your keyboard with different names than those used in this book. If you’re not sure which key is which, see the NEXTSTEP User’s Guide and the owner’s guide for your computer.
After you turn on the computer and log in, you enter the workspace, which is where you work in NEXTSTEP.

Your workspace may not exactly match the one shown below, but it will have many of the same features.

**Icons** are small pictorial representations of things you work with in the workspace.

The **application dock** (or **dock**, for short) is the column of icons along the right edge of the workspace. All but one of the icons in the dock represent **applications**. (The exception is the recycler icon—usually at the bottom of the dock—which is described in “Organizing,” later in this book.)

The icon at the top of the dock represents the Workspace Manager™ application.

The main Workspace Manager window is called the **File Viewer**. It gives you access to your files.

The Workspace **menu** contains **commands**, such as **Edit** and **Log Out**, that you can choose to make the Workspace Manager do something.

The **cursor** is the small black arrow that moves when you move the mouse. You move the cursor to point to things on the screen.
Using the mouse

Except for typing text, you can do all your work with the mouse (or whatever pointing device you have). You just need to know a few basics.

- Slide the mouse on a smooth surface.
  As you slide the mouse, the cursor moves on the screen.
- Point to an object on the screen by moving the mouse so the cursor is on top of the object.
- Click by pointing to an object and, without moving the mouse, pressing and immediately releasing a mouse button.
- Press by pointing to an object and, without moving the mouse, pressing and holding down a mouse button.

Press a black arrow button (if there is one) in the File Viewer window. As long as you press, the button is highlighted; information may also move in the window.

- Drag by pointing to an object, pressing and holding down a mouse button, moving the cursor to a new location (by sliding the mouse), and then releasing the mouse button.

Drag the title bar at the top of the File Viewer window. The window moves in the workspace.

The cursor changes shape as you work. The most common forms are:

- an arrow for pointing to objects
- an I-beam for editing text
- a question mark for getting help
- a rotating disk indicating that the application is busy and you must wait (or switch to another application)

Tip: Initially, you can use either the left or right mouse button—they each have the same effect.
**Choosing commands**

One way you tell an application what to do is by choosing a command from a menu. Each application has a *main menu* that appears in the upper left of the workspace while you’re working in the application.

- To choose a command, click it in the menu. The command is highlighted and carried out.

A command with an arrow opens another menu, called a *submenu*, which contains more commands.

The submenu stays open until you choose a command from another menu, such as the main menu. (You can also close a submenu by simply choosing the command that opened it.)

To keep a submenu open, detach it by dragging its title bar.

To close a detached submenu, click the close button that appears in the right of its title bar when it’s detached.

A dimmed command (shown in gray rather than black) is currently unavailable—usually because it’s not relevant to what you’re doing at the moment.

If a command has a character next to it, you can choose that command from the keyboard by holding down the Command key while typing that character.

When you choose a command that’s followed by an ellipsis (…), a panel asks for additional information about how to carry out the command.
Logging out

When you’re done working with NEXTSTEP, log out to quit all applications that are running.

Before logging out, make sure you save any work you’ve done in an application, or your work will be lost. (Saving is described in “Files,” later in this book.)

1 Choose the Log Out command from the Workspace menu. (If the Workspace menu isn’t visible, click in the File Viewer window or double-click the NeXT™ icon at the top of the dock to make the Workspace menu appear.)

The Log Out panel opens (a panel is a kind of window, often used to ask you simple questions).

If you change your mind about logging out (or if you choose Log Out by accident), click the Cancel button in the Log Out panel.

2 Click the Log Out button in the panel.

If an application contains unsaved work, a panel may open, giving you a chance to save your work.

Logging out returns you to the login window.

Choose Log Out from the Workspace menu.

Then click the Log Out button in the panel.

Tip: A ⌘ symbol on a button indicates that pressing the Return key has the same effect as clicking the button.
Turning off the computer

If you don’t expect to use your computer for a day or two, you should turn it off.

As when logging out, make sure you save any work you’ve done in an application before turning off the computer.

1 Choose the Log Out command from the Workspace menu. The Log Out panel opens.
2 Click Power Off in the panel.

If an application contains unsaved work, a panel may ask if you want to save your work before the application quits and you turn off the computer.

Some computers turn themselves off automatically when you click the Power Off button. Otherwise, a message asks you to wait until it’s safe to turn off the computer.

3 When a message says it’s OK to turn off the computer’s power, press the power switch on the computer.

Caution: Don’t turn off the power to the computer before a message says it’s OK, or else you might damage your startup disk.

4 If your display and peripherals have power switches, turn them off, too.

When the login window is showing, you can turn off the computer or restart it by clicking one of these buttons in the login window.
Starting up an application

Your computer comes with several applications, such as Edit and NeXTmail™. You can keep icons for these and other applications in the application dock.

- To start up an application from the dock, double-click its icon. (To double-click, click twice in quick succession).

The icon is highlighted while the application starts up, and then the application’s main menu appears. One or more windows may also open.

Notice that before you start up an application, its icon in the dock has an ellipsis [••••] in its lower left corner. After you start up the application, the ellipsis goes away, indicating that the application is running.

You can also start up applications by double-clicking their icons in the File Viewer or by opening files from the Workspace Manager (see “Files”).

You can start up an application by double-clicking its icon in the dock.

When you first start up an application, the Workspace menu goes away and the application’s main menu appears in its place.

The application may also open one or more windows.
**Running multiple applications**

You can run several applications at once—for example, so you can look up information in Digital Librarian™ while reading your Mail messages.

**To run multiple applications**

- Start up each application you want to run.

  Each time you start up an application, its main menu appears in place of any menus that were previously visible. Typically, one or more other windows open, often covering windows that are already open (see “Windows”).

Although several applications might be running, you work in only one at a time—the active application. The active application is the one whose menu is showing.

When several applications are running, you can switch to the one you want to work in.

**To switch applications**

- Click in a window that belongs to the application you want. Or double-click the application’s icon.

  When you switch applications, the menus switch. If you click in a window, that window comes to the front.
Hiding an application

If you’re done working in an application for now but may use it later, you can hide the application to get its windows out of the way.

► Choose Hide from the application’s main menu.

All its windows disappear, but the application is still running and you don’t lose any unsaved work. If other applications have windows open, one of those applications becomes active.

By hiding applications, you can have several applications running and easily accessible. However, your workspace remains free of windows you’re not using at the moment.

When you’re completely done using an application, quit the application—as described on the page after next.

Tip: If you hold down the Command key while double-clicking an application’s icon in the dock, that application becomes active and all other running applications are hidden.
Unhiding an application

Whenever you want to work in an application (whether or not it's hidden), you can get to it by double-clicking its icon.

Double-click the application’s icon.

Its windows appear again—just as though the application hadn't been hidden—and the application becomes the active application.

If you hide the Workspace Manager, you can unhide it by double-clicking the NeXT icon at the top of the application dock.

Tip: Whenever you want to work in an application (whether or not it's hidden), you can get to it by double-clicking its icon.
Applications

**Quitting an application**

When you’re completely done working in an application, quit the application.

- Choose Quit from the application’s main menu.

If you haven’t saved your work in the application, a panel gives you a chance to save before quitting. Then the application’s windows close.

If you don’t save your work when you quit, it is lost (see “Files”).

When you log out, all running applications quit automatically.

*Tip:* Hide rather than quit applications you plan to use later—it takes less time to unhide an application than it does to start it up again.
NEXTSTEP presents information in windows. Several windows may be open in your workspace at the same time.

Some windows, such as one containing an Edit document, provide a place to work. Others, such as panels, give you options for controlling an application. Or they may simply provide information.

To organize your workspace, you can change the size and shape of windows or make them disappear completely, as illustrated with the Edit window below.
Reordering windows

Like sheets of paper loosely stacked together, windows can overlap or completely cover each other.

- To bring a window forward so you can work in it, click in it.

  Take care not to click a button (such as a window’s close button) when you click in the window.

The window comes forward and its title bar typically turns black, indicating that it’s the key window. When you use the keyboard, anything you type appears in the key window.

Remember that clicking in a window also makes that window’s application the active application (if it isn’t already).

---

Emily Bright releases first album: *Git on down the road*

Emily Bright’s first album is a bright spot on a stormy horizon. The eighteen-year-old singer from the streets of Chicago combines the achingly message from her generation. But varied passion—doesn’t let you make a difference.

Legend, Skip James, but Bright is the. Bright learned her craft hanging clubs on Chicago’s South Side. Self, kids living on the streets. The These kids are not just looking for a for a future, not only for themselves message loud and clear.
**Scrolling**

When a window contains more than it can display at one time, you can scroll to see more. If a document window displays one page of a 25-page document, for example, you scroll to see the other pages.

The most common way to scroll is by using a scroller—a gray bar with a knob and scroll buttons.

Vertical scrollers are for scrolling up and down, while horizontal scrollers scroll left and right.

In some cases, you scroll using buttons that aren’t in a scroller but that stand alone. (A dimmed button means you can’t scroll any further in that direction.)

---

Click in the gray bar to scroll quickly—the scroll knob jumps to the position under the cursor as though you dragged it there.

Drag the scroll knob to scroll continuously.

**Tip:** The scroll knob’s size and position indicate how much of the total information you’re viewing and where you are in the document. For example, if you’re on page 2 of a 3-page document, the vertical scroller fills the middle third of the bar.

Click a scroll button to scroll by a line or other increment in the direction the button points. Press a button to scroll continuously by increments.

---

Emily Bright releases first album:

*Git on down the road*

Emily Bright’s first album is a bright spot on a stormy horizon. The eighteen-year-old singer from the streets of Chicago combines the aching sound of old-time blues with a searing message from her generation. But her voice—full of energy and open-throated passion—doesn’t let you wallow in despair. It makes you want to make a difference.

The title cut is a tribute to old-time blues legend, Skip James, but Bright is about to become a legend in her own right. Bright learned her craft hanging around outside the backdoors of bars and clubs on Chicago’s South Side. She got her message from kids like herself, kids living on the streets. The message is not what you might expect. These kids are not just looking for a free meal or a dealer. They’re looking for a future, not only for themselves but for the planet. And Bright sings the message loud and clear.

Emily Bright may have her roots in a blues past, but she’s got her eyes on the future. Her sound is soulful, down-and-dirty, and innocent at the same time. This woman’s going to soar, and *Git on down the road* is going to set an old tradition on wings in a fresh new direction.
The File Viewer

NEXTSTEP organizes information in files and folders. A file might contain a memo, a drawing done in a graphics application, or the application itself. Folders contain files and other folders.

The files and folders in your computer are organized in a hierarchy, where the root folder branches into other folders, which can contain files and more folders, to as many levels as you want.

To get to files and folders, you use the File Viewer—a Workspace Manager window that appears when you enter the workspace. Files and folders appear as icons in the File Viewer.

At the top of the File Viewer is the shelf, where you can put icons of files or folders you use often and want to keep handy.

In the middle of the File Viewer is the icon path. It shows you where you are in the file system. The highlighted icon at the right is the current file or folder. The icons to the left of the current folder trace the path back up the hierarchy to the root folder, which is represented by a computer icon.

At the bottom of the File Viewer, the current view displays the files and folders in the current folder.

When you log in, your home folder is the current folder, and its contents are displayed in the current view. Your home folder has the same name as your user name.

Tip: If you see words instead of icons in your File Viewer's current view, choose Icon from the Workspace Manager's View menu, so what you see in your File Viewer more closely matches the pictures in this book.
Finding files and folders

You find files by opening folders.

- To open a folder, double-click its icon.
- To move back up the hierarchy, click a folder icon in the icon path.
- To open a folder on the shelf, click its icon there.

When you open a folder, its branch of the hierarchy appears in the icon path with the folder’s icon selected. The folder’s contents are displayed in the current view at the bottom of the window.

Many folders have an icon like this. But others have icons that indicate something special about the folder’s contents or location.

- This icon marks your home folder, which contains your personal files.
- This icon marks someone else’s home folder.
- This icon marks a folder that’s a floppy disk you’ve inserted in a drive.
- This icon marks the Net folder, which contains folders on other computers on the network (if you’re connected to one).

It doesn’t matter where a folder is or what icon it has. You typically work in all folders the same way.

Tip: You can use the Clean Up Icons command in the View menu to straighten up the current view of icons.

Click a folder icon on the shelf or in the icon path to display the folder’s contents.

Or double-click a folder icon here to open it.
Stocking the shelf

The shelf is a convenient place to put icons of files and folders you use often.

To put a file or folder’s icon on the shelf

1. Select a file or folder by clicking it in the icon path or in the current view.
   Its icon is highlighted.

2. Drag the highlighted icon into an empty space on the shelf and release the mouse button when a ghost image of the icon appears.

To remove an icon from the shelf

- Drag the icon off the shelf—out of the File Viewer window and into the workspace.

  The icon is removed from the shelf, but the file or folder is not deleted—you can still find it in the icon path or in the current view at the bottom of the window.

Your home folder’s icon is always in the upper left corner of the shelf—you can’t remove it.

Add an icon to the shelf by dragging it from the icon path or from the current view.
Customizing the application dock

To add an application's icon to the dock

1 Use the File Viewer to find the application whose icon you want to add to the dock.

Many applications are in the NextApps folder, which is in the root folder. If necessary, click the root folder icon (it looks like a computer) in the icon path and when its contents appear in the current view, double-click the NextApps folder to open it.

2 Select the application by clicking it in the File Viewer.

The application's icon is highlighted in the icon path.

3 Drag the highlighted icon into an empty space in the application dock and release the icon when a ghost image of it appears in the dock.

To remove an application's icon from the dock

► If the application isn’t running, just drag its icon out of the dock—into the workspace.

► If the application is running, hold down the Command key and drag it out of the dock.

You also have to hold down the Command key to drag the recycler from the dock.

To use the application again, you can find it in the File Viewer.

Drag an application icon from the File Viewer into an empty space in the dock and release the icon when a ghost image of it appears.

You can't remove the NeXT icon from the dock.
**Opening a file from the File Viewer**

You can open files you see in the File Viewer.

1. Find the file by opening the folder it’s in.
2. Double-click the file’s icon.

You can double-click a file’s icon in the current view, in the icon path, or on the shelf.

If the file is an application, the application starts up. Otherwise, the application associated with the file starts up (if it isn’t already running) and displays the file’s contents in a window.

You can tell what application a file will open in by the file’s icon, which resembles the application’s icon. For example, if you double-click an Edit file icon, Edit opens a window that displays the file’s contents.

When an application that isn’t in the application dock starts up, its icon appears at the bottom of the screen. If you like, you can drag the icon into the dock. Otherwise the icon disappears from the bottom of the screen when you quit the application.
Opening a file from within an application

When you’re working in an application, you don’t have to go to the Workspace Manager to open a file. You can open it from within the application itself.

1. Choose Open from the application’s document menu.

The document menu may be titled Document, File, Project, or something else. It’s in the main menu just below Info.

A panel with a browser opens. Browsers are lists of files and folders displayed in one or more columns. At the top of each column is the name of the folder that contains the files and folders in that column. With browsers you can navigate quickly through a hierarchy of files and folders.

2. Locate the file in the panel’s browser.

3. Click the file to select it.

The name appears in the Name field.

4. Click OK.

The panel disappears and the file opens in its own window.

You can use the disk buttons in the panel to work with floppy disks. (Working with disks is described in the User’s Guide and in the on-line help. See “For More Information.”)

When you choose an application’s Open command, a panel with a browser opens.

Click a file to select it. Or just double-click a file to open it directly.

Click the left or right arrow to see folders above or below the current view of the file system.

Click a folder (folders are marked by an arrow[>] to display its contents in the next column.

Click to open your home folder.

Click to open the selected file.

Click to close the panel without opening a file.
Creating a file

You create a file in an application to store your work.

1. Choose New from the application’s document menu.
   A new, untitled window opens.

2. Do some work in the window, such as typing.

3. Save the window’s contents in a file by choosing Save from the document menu.
   The Save panel opens. It contains a browser.

4. In the browser, click the folder where you want to save the file.

5. Type a name for the file in the panel’s Name field.

6. Click OK.
   The name you entered appears in the window’s title bar.

If you close a new window without saving your work, no file is created and the work you’ve done is lost.

The Save command opens a panel for saving the contents of a window in a file.

Bessie Smith
The Empress of the Blues, she was born in poverty only to become one of the most renowned—and highest paid—blues performers of her day.
Saving changes to a file

To save changes you've made to a file

- While working in a file, choose Save from the application's document menu.

  The contents of the window are saved, replacing the last saved version of the file.

Tip: Save changes frequently, not just when you're about to close a file.

To save a copy of a file under a different name

1. While working in the file, choose Save As from the document menu.

   The application's Save panel opens.

2. Use the panel to give the new file a name and put it in a folder (as described on the previous page).

   The original file is put away without changes. The file with the new name is saved with any changes, and you can continue working with that file in the window.

File on a disk before saving

Edited copy in window

File on a disk after saving

Edited copy in window

You know a window contains unsaved work if its close button is partially drawn.

After saving, the close button returns to normal.
In the early 20th century, this Arkansas bar room and back alleys were the centers of a thriving music industry, where people went—and across the river of the world.
Typing text

In most applications, you type text the same way whether you’re editing a document or entering a value in a field.

1 Click in the window where you want to type.
   For example, click in an Edit document window.
   The window you click in becomes the key window (if it isn’t already), and the insertion point appears.

2 Type your text.
   You don’t need to press the Return key at the end of each line. The insertion point moves forward as you type each character. Lines break automatically between words:

   Over the course of a half century, Memphis Slim took the Blues to Chicago—and across the ocean to the big-name Blues venues of the world.

3 To end a paragraph and move the insertion point to the next line, press the Return key.

4 To insert text, click where you want the text.
   The insertion point appears where you click:

   Over the course of a half century, Memphis Slim took the Blues to Chicago—and across the ocean to the big-name Blues venues of the world.

5 Type what you want to insert.
   The text you type is inserted, and lines in the paragraph are adjusted to make room for the new text:

   Over the course of a half century, Memphis Slim took the Blues from the barrelhouses and dives of Beale Street to Chicago—and across the ocean to the big-name Blues venues of the world.

You can also press one of the arrow keys on the keyboard to move the insertion point.

The cursor becomes an I-beam when you can enter text.

Text you type appears at the insertion point—which is marked by the blinking vertical bar.
**Deleting and replacing**

To delete text

1. Put the insertion point directly after the text you want to delete.

2. Press the Backspace key to delete the character to the left of the insertion point. Keep pressing Backspace to delete as many characters as you want.

Or

1. Select the text you want to delete by dragging across it.

   The selection is highlighted.

2. Press Backspace to delete the entire selection.

**To replace text**

1. Select what you want to replace.

2. Type the new text.

   As soon as you start typing, the selected text is deleted and the text you type is inserted in its place.

In some applications, you can also use these editing techniques with graphics. For example, if you select a graphic and press Backspace, the graphic is deleted.

---

Selected text is highlighted to make it stand out.

Press Backspace to delete selected text. Or type new text to replace what you selected.

---

Tip: As a shortcut, select a word (and the space that follows it) by double-clicking the word. Select a paragraph by triple-clicking it.

---

Over the course of a half century, Memphis Slim took the Blues from the barrelhouses and dives of Beale Street to Chicago—and across the ocean to the big-name Blues venues of the world.

---

Over the course of a half century, this Arkansas pianist took the Blues from the barrelhouses and dives of Beale Street to Chicago—and across the ocean to the big-name Blues venues of the world.

---

31
**Moving and copying**

**To move text**
1. Select the text you want to move.
2. Choose Cut from the Edit menu.
   The selected text is deleted.
3. Put the insertion point where you want to move the text you cut. Or select text you want to replace with the text you cut.
4. Choose Paste from the Edit menu.
   The text is inserted just as though you typed it.

**To copy text**
1. Select the text you want to copy.
2. Choose Copy from the Edit menu.
3. Put the insertion point where you want to insert the text you copied. Or select text you want to replace.
4. Choose Paste from the Edit menu.
   A copy of the text is inserted.

---

**Tip:** You can choose Paste repeatedly to paste what you last cut or copied as many times as you like.
**Changing fonts**

You can change the text font to emphasize key phrases with *bold* or *italics*—or to give the text a different look altogether.

1. Select the text you want to change.
2. Choose the Font Panel command.
   
   The Font Panel command may be in the Format, Font, or other menu, depending on the application.
   
   The Font Panel opens.

3. Click in the Family column to select a font family—a collection of characters with a consistent design.
4. Click in the Typeface column to select a typeface, such as *bold*, *italic*, or *bold italic*.
5. Click in the Size column to select a font size.
6. Click the Set button to apply the new font to your text selection.

You can also make selected text bold or italic by choosing the Bold or Italic command in the Font menu.
ORGANIZING

Prelim Bios
Renaming files and folders

You can rename an existing file or folder by editing its name in the File Viewer.

1. Select the file or folder you want to rename.

   The icon of the selected file or folder is highlighted. You can edit the file name in the icon path or in the current view.

2. Click in the name to select an insertion point or select all or part of the name you want to replace.

   You edit the name as you normally edit text.

3. Press Return.

   The new name appears below the icon and everywhere else the file appears.

   If you don’t have permission to rename a file or folder (usually because it belongs to someone else), a panel alerts you and the unedited name is restored. (Permissions are described in the User’s Guide and in the online help. See “For More Information.”)

Caution: Don’t rename an application, or the Workspace Manager won’t be able to start it up when you open a file associated with it.
Creating a folder

You can create folders to organize your files.

1. Open the folder where you want to create a new folder.
   Make sure its icon is highlighted in the icon path.

2. Choose the New Folder command from the Workspace Manager File menu.
   A folder named NewFolder appears in the folder you opened. The name NewFolder is selected for editing.

If you don’t have permission to change the contents of a folder (usually because it belongs to someone else), the New Folder command is dimmed in the menu. (Permissions are described in the User’s Guide and in the on-line help. See “For More Information.”)

3. Type a new name for NewFolder and press Return.
   The new folder is empty at first, but you can save new files in it, create other folders in it, and move or copy existing files or folders into it.
Moving files and folders

You can move files or folders into other folders in the File Viewer—for example, to move a file into a folder you’ve just created.

1. Select the file or folder you want to move and drag it to the shelf.

2. Open the folder you want to put it in.

   The folder’s icon is highlighted in the icon path.

3. Hold down the Command key as you drag the file or folder you want to move from the shelf to the folder in the icon path. (On most keyboards, the Command key is the key to the left of the space bar.)

   The cursor changes color and the folder opens to confirm that the file or folder will be moved into it. If you don’t have permission to change the contents of a folder, the cursor stays black and the folder’s icon doesn’t open.

4. Release the mouse button.

   What you dragged is removed from its previous folder and placed in the folder you dragged it to.

Tip: You can also move files and folders by dragging them into or out of the current view.
Copying files and folders

To copy a file or folder

1. Drag the file or folder you want to copy onto the shelf.

2. Open the folder where you want to put the copy.
   The folder is highlighted in the icon path.

3. Hold down the Alternate key as you drag the file or folder you want to copy from the shelf to the folder in the icon path. (On most keyboards, the Alternate key is the key to the right of the space bar.)
   The folder icon opens and the cursor changes to a CO to confirm that you’re making a copy.

4. Release the mouse button.
   A copy of the file or folder is created in the folder you dragged it to.

To make a copy of a file or folder in the same folder

1. Select the file or folder you want to copy and choose Duplicate from the Workspace Manager File menu.
   A copy of the selection appears in the same folder with its same name, preceded by CopyOf.

2. Rename the copy, if you like.

Tip: You can also drag an icon from the icon path or current view into a folder that’s on the shelf.
Deleting files and folders

To delete a file or folder

1 Select the file or folder you want to delete.
2 Drag its icon from the File Viewer to the recycler icon.
3 When the recycler arrows start to rotate, release the mouse button.

The file or folder is deleted. When you recycle a folder, you delete everything in it, including the contents of all the folders it contains.

The files and folders you recycle aren't gone for good until you empty the recycler.

To retrieve a deleted file or folder

1 Double-click the recycler icon.
   The recycler window opens. It contains all the files and folders you’ve put in the recycler since you last emptied it. You may have to scroll to find the file or folder you want to retrieve.
2 Drag the file or folder you want to retrieve to a folder in the File Viewer.
   The file or folder reappears in the File Viewer.

Tip: You empty the recycler and destroy its contents for good by choosing the Empty Recycler command from the Workspace Manager’s File menu. You should empty the recycler periodically to reclaim disk space.
MAIL, PRINTING, & FAXING
Opening your mail

1. Start up or unhide the Mail application. The Active mailbox window opens, with a list of the mail you’ve received. New mail you haven’t read is marked with a ∙.

2. Click a message in the summary area. The message is displayed in the lower portion of the window.

When Mail is running, you can tell at a glance whether you have new mail by the appearance of the Mail icon in the dock. You can also tell how many pieces of mail you haven’t read yet.

![Number of unread messages]

No new mail
You have new mail!

---

Date: Wed, 3 Jun 94 09:06:02 GMT-0800
From: poupon (Pierre Poupon)
To: grey
Subject: Materials for festival program
Cc: laurier, mathieu, bourget, starr

Bonjour, Kaya!

I received the fax yesterday with the preliminary designs for the festival program and have passed them around here. Everyone applauds. As for the photographs you requested, I’m afraid it will be the end of the week before we can send them to you. M. Laurier in our legal department has to clear them. I hope that won’t slow you down.

Here’s a file with some comments from our Paris office:

I look forward much to seeing you again at this year’s festival!

Au revoir

Pierre
Sending mail

If you have a message, a file, or even a folder full of files you want to share with others, you can send it in a Mail message.

1. Start up or unhide the Mail application.
2. Click the Compose button in the Active mailbox.
3. Type the addresses of the people you want to send the message to in the To field.
   Separate multiple addresses with a comma and a space.
   For more information about addresses, see the User's Guide or the on-line help.
4. Type a subject for the message in the Subject field.
5. Type addresses of people you want to send a “carbon copy” of the message to in the Cc field.
6. Type your message in the main part of the window.
   If you’re sending the message to people who use NEXTSTEP, you can use different fonts in your message. You can even drag in a file or folder from the File Viewer.
7. When your message is complete, click Deliver.

Tip: If you’re sending mail to people who don’t use NEXTSTEP, click the NeXT Mail button (so it changes to Plain Text or MIME Mail) before you click Deliver.

Some graphics files are displayed as graphics, instead of as file icons.

Hey Everybody!!!

Don’t forget that this Friday night is the first-ever Bay Area appearance of recent Blue Planet “signee” and scat sensation Dido Estevan

8:00 pm at the Sweetwater Pavilion

Come early for press hour and hors d’oeuvres (don’t forget your badges).
Preparing a file for printing or faxing

Before you print or fax a file, you can make a few choices about how you want your pages to appear.

1. Open the file you want to print or fax and choose the Page Layout command.

   The Page Layout command is often in an application’s Format menu or main menu.

   The Page Layout panel displays the current page layout settings for the file. The paper dimensions are shown in the Width and Height fields.

2. Use the Paper Size or orientation buttons if you want to change the paper size.

3. Use the Layout button to change the number of pages that fit on a sheet of paper.

4. Use the Units button to change the unit of measurement for Width and Height.

5. Type a percentage in the Scale field to change the size of your pages.

6. Click OK.

Some settings affect your pages on screen, while others take effect only when you print or fax.
**Printing a file**

You can print a file on a printer that's connected to your computer or that's available on the network.

1. Open the file you want to print and choose Print from the main menu.
   The Print panel opens.

2. Type the number of copies you want in the Copies field.

3. If you don't want to print the whole file, type the starting and ending page numbers of the pages you want to print in the From and To fields.

4. Use the Paper Feed button to feed paper automatically from the paper cassette or to feed individual sheets by hand.

5. Use the Resolution button to choose the number of dots per inch (dpi).

6. If your printer has other options, use the Options button to set them.

7. Click Print.
   The Progress field displays the message "Writing page x" as it prepares each page for the printer.

---

**Print** panel:

- **Name:** Repertoire_Color_Printer
- **Note:** In the record library.
- **Progress:**

  - **Local Printer**
  - NeXT 400 dpi Level II Printer
  - Repertoire_Color_Printer
  - NeXT Color Printer
  - Sly_Personal_Printer
  - NeXT 400 dpi Level II Printer

**Buttons:**

- **Copies**
  - [ ] 1
  - [ ] All
  - [ ] From
  - [ ] To
- **Paper Feed**
  - [ ] Cassette
  - [ ] Resolution
  - [ ] 360 dpi
- **Options...**
- **Save...**
- **Preview**
- **Fax...**
- **Cancel**
- **Print**

**Instructions:**

- If more than one printer is available, click the printer you want.
- Click to set special options for the selected printer.
- Click to preview your pages on screen instead of printing them.
- Click to print the file.
**Faxing a file**

If you have a fax modem, you can fax your pages to anyone who has a fax machine or fax modem.

1. Open the file you want to fax and choose Print from the main menu.
   
The Print panel opens.

2. Click the Fax button.
   
The Fax panel opens.

3. Enter a name and fax phone number by typing or by clicking address book entries in the browser.
   
The address books that appear in the Fax panel are the same as the ones in the Workspace Manager. (See the User's Guide or Workspace Manager's on-line help.)

4. If you don't want to fax the whole file, type starting and ending page numbers in the From and To fields.

5. Check Receipt to get a mail message when the file has been faxed.

6. Check Fine to increase the sharpness of the pages you fax.

7. Click Edit to change the cover sheet you send with the fax.

8. Click Fax Now.
   
The Progress field displays the message “Writing page x” as it prepares each page for the fax modem.
Clicking for help

When you’re working in the Workspace Manager, Mail, Edit, and in many other applications, you can get help with your work by clicking an object on the screen.

1. Hold down the F1 key on the keyboard.
   The cursor changes to a question mark ?.
   If your keyboard doesn’t have an F1 key, you can try getting the question mark cursor by holding down the Alternate and Control keys at the same time.

2. Click the command, window, button, or other object you want help with.
   The Help panel opens, with information about the object you clicked.
   You can scroll in the Help panel to read more, or click any word or phrase marked with a button to get help on a related topic.

Tip: If you want help with help, use the question mark cursor to click the Help command in the Info menu.

When you press the F1 key, the cursor changes to a question mark ?. Use it to click commands, windows, or buttons you want to find out about.
Getting help with a task or topic

To get help with a specific task
1. Choose Help from the Info menu. The Help panel opens.
   If the Help panel is already open, click in it to make it the key window.
2. Click an entry in the table of contents.
   Instructions for the task you clicked appear in the Help panel.
   You can scroll the table of contents to find the task you want help with.

To get help with a specific topic
1. Click the Index button in the Help panel.
   An index of topics appears.
2. Click the topic you want help with.
   Information about the topic you clicked appears in the Help panel.

Click to view an index of topics.

Click to view the previous topic you chose.

Click a task in the table of contents to get help with that task.

Drag this knob to resize each area.

Click a topic to get help with a related topic.

Format a message

To set margins, indentation, and tabs, choose Show Ruler from the Text menu and adjust the markers. To realign text in a paragraph, choose Align Left, Center, or Align Right from the Text menu.

Left margin marker
First line indentation marker
Body indentation marker
Tab marker

Right margin marker

Open the Text menu by choosing Text from the Format menu.
You use a ruler to alter margins, indentation, and tab stops. The ruler is initially hidden, but you can make it appear in a Compose window with the Show Ruler command.
Adjust markers by dragging them along the scale of the ruler. The margin markers set the left and right margins of all text in the message.
Searching for help

If you don’t see a task or topic you want help with in the table of contents or index, you can search for a word in all the help for an application.

1. Open the Help panel.
2. Click in the field at the top of the Help panel and type the word you want to get help with.
3. Click Find.

The first topic that contains the word you typed appears in the Help panel. The word you typed is highlighted.
4. To find the next occurrence of the word, click Find again.

The next place where the word occurs appears in the panel.
In addition to this *Quick Start* and the on-line help described in the previous pages, there are a few other places to turn when you have questions about NEXTSTEP.

- The *User's Guide* explains all you need to know to use NEXTSTEP—from the basics touched on in this *Quick Start* through the details of the user applications and utilities bundled with the software. The *User's Guide* offers task-oriented, step-by-step instructions as well as concepts and a complete command reference.

- *Power Tips* is a quick reference to useful tips and shortcuts in NEXTSTEP. It includes a complete list of NEXTSTEP user and system administration books, journals, and on-line resources. It also tells how to contact NeXT for more information and services.

- *Release Notes* describes the contents of the current release of NEXTSTEP, plus a list of known problems.

- *Installing and Configuring NEXTSTEP* shows how to install NEXTSTEP on your computer and how to reconfigure NEXTSTEP when you reconfigure your computer and its devices.

- *Upgrading* shows how to upgrade earlier releases of NEXTSTEP to the most current release.